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1 INTRODUCTION 

1.1 PURPOSE 
The XPVD Interface Control Document (ICD) describes the interfaces between the Target 
Generator Facility Chassis and XPVD boxes.   
 

1.2 ORGANIZATION 
The TGF at the Federal Aviation Administration William J. Hughes Technical Center (FAA 
Technical Center) is managed by the System Simulation Support Branch, ACT-510, of the 
Aviation Simulation and Human Factors Division, ACT-500. 

2 OVERVIEW 

2.1 XPVD System Overview 
The XPVD provides a graphical interface of the targets the TGF is creating.  These flight 
plan targets are being used to create radar for the Technical Center ATC Laboratories.  
Figure 2-1 shows a general overview of the major components of TGF. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2.1-1 TGF Target Generation Synopsis 

2.2 XPVD Interfaces 
 
The following XPVD interfaces will be described in this document: 
 

TGF 
CHASSIS 

 SDSERVER 
 

XPVD  

RBX BYTEX ATC LABS 

          ECO 
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• User interface  
 
This interface describes the actions that a programmer, controller, or simulation 
pilot would use while working with XPVD.  

   
• SDSERVER interface 
 

The SDSERVER serves the XPVD workstation with flight data generated by the 
TGF chassis. 
 

• Simulation Pilot Workstation (SPW) interface 
 
This section describes the communication interface between the Exercise Control 
Operator (ECO) and the SPWs. 
 

2.3 XPVD Hardware 
 
XPVD can run on three different hardware platforms. 
 
• One of the hardware platforms is 100 or 120 Megahertz Pentium personal computers 

running the Linux operating system.   In addition, the Pentium Pro 200 fits into this group 
of hardware. 

 
• Another set of hardware platform is in our PRM lab.  This room has Sony 2048 X 2048 

pixel displays that plug into Pentium Pro 200 Personal Computers or Sun workstations 
running Solaris. If need be, XPVD could probably run on a Pentium 75 running Solaris.  
It also runs on IBM RISC running AIX. 

 
• The last set of hardware consists of Silicon Graphic computers running Irix.  

3 XPVD User Interface 
 

3.1 Getting Started 
 
Find an XPVD workstation and logon as XPVD, password: xpvd. 
Slide the mouse on XPVD and then choose the desired airspace map. 
Select the TGF menu icon and click “specify”. 
Click on the chassis the simulation is running on. 
Click “OK” 
Select the TGF menu icon and click “connect”. 
As soon as the simulation has begun, targets appear on the XPVD screen. 
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3.2 Exiting XPVD 
 
Select the FILE Menu icon and click the mouse on “exit”. 

3.3 Summary of XPVD Commands 
 

The XPVD display consists of seven main menus including the Help menu. The seven menus 
are: 
 
• File,  
• Clock,  
• Display,  
• TGF,  
• Customize,  
• Transform, and Help. 
 

Figure 3.3-1 Summary of the XPVD Commands 
 

 

3.3.1 FILE Menu 
 
The submenus of the File menu are Read, Point, command, Clear, New View, Close, and 
Exit.  See the figure below. 
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Figure 3.3-2 XPVD Main menu – File Sub-menu 
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3.3.1.1 Read 
 
The READ menu, shown below is used to ‘read in’ the specific file containing the specific 
map details and all static data. Normally this file is read in automatically when the XPVD 
screen is brought up together with a specified argument.  
 

Figure 3.3-3 Read Pop-Up from File Menu 
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3.3.1.2 Point 
 
The POINT_popup uses dynamic data and it data is always time-stamped. The "POINT" files 
are always used in conjunction with pre-recorded playback.  
 

Figure 3.3-4 POINT POP-UP FROM FILE MENU 
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3.3.1.3 Command 
 
The command pop-up menu is used to enter commands directly into the XPVD. A case in 
point is fix entering. The command to display a fix is as follows:  
FIX APG LL 392830.0 761030.0,  
followed by the command: 
DISPLAY FIX APG 
 

Figure 3.3-5 COMMAND POP-UP FROM FILE MENU 
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3.3.1.4 Clear 
 
The Clear submenu and sub-submenus will clear all the graphics from the submenus shown 
in its pull down menus. 
 

Figure 3.3-6 CLEAR POP-UP FROM FILE MENU 
 

3.3.1.5 New View 
The remaining submenus within the File menu are trivial. One of these sub-menus is New 
View.  New View gives you an empty new window.  
 

3.3.1.6 Close 
The Close sub-menu closes the current window but does not exit the XPVD application.  
 

3.3.1.7 Exit 
The Exit sub-menu shuts down the XPVD application completely. 
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3.3.2 CLOCK Menu 
 
The Clock menu controls the XPVD clock and is used for pre-recorded data.  
It is shown in the main display below. 
 

Figure 3.3-7 XPVD Main menu – Clock Sub-menu 

 
 
The Clock menu is shown below. 
 

Figure 3.3-8 CLOCK POP_UP Menu 

 

3.3.2.1 Run 
RUN starts the clock.  
 

3.3.2.2 Reset 
RESET sets the clock to 24:00:00.  
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3.3.2.3 Set 
SET gives you the opportunity to arbitrarily set the clock at any desired time within the 
limits of the pre-recording. 
 

Figure 3.3-9 SET CLOCK POP-UP MENU 

 
 
 

3.3.2.4 Stop 
STOP terminates the clock. 
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3.3.3 DISPLAY Menu 
 
 
The DISPLAY menu consists of 8 sub-menus, which may or may not have their own menus. 
The Display menu is shown below from the main XPVD panel. 
 
 

Figure 3.3-20 XPVD Main menu – Display Sub-menu  

 
 

3.3.3.1 Airways 
 
The AIRWAYS menu will contain all the airways in the particular simulation exercise 
currently running. If there are none it will be indicated by an appropriate dialog pop-up. Any 
airway of interest can be chosen from the AIRWAYS submenu.  
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Here AR010 is selected as shown. 

Figure 3.3-13 Display Menu – Airways Chosen 
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 Below, the selected airway is shown with its fixed radial distances (FRD) depicting starting 
and ending points.  
 
 
 
 

Figure 3.3-12 AR010 Airway is shown 
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3.3.3.2 Data Blocks 
 
The Data Blocks menu enables and disables the aircraft’s data blacks. An example best 
illustrates this function. The figure below shows a sample of airspace with the data blocks 
turned on. 
 

Figure 3.3-13 Data Blocks turned on 
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The figure below shows a sample of airspace with the data blocks turned off. 
 
 

Figure 3.3-14 Display Menu – Data Blocks turned off 
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3.3.3.3 Fixes 
 
The FIX submenu contains all the fixes in the current exercise. Each fix when chosen will be 
able to be placed on the map according to its latitude and longitude coordinates. In the 
example below, fix ABBIT is chosen in the pop-up menu and displayed on the XPVD screen.  
 
 

Figure 3.3-15 Display Menu – Fix Sub-Menu with Fix ABBIT chosen for display 

 

3.3.3.4 Flight Plans 
 
The Flight Plan submenu of the Display main menu gives all the flight data of each aircraft in 
the scenario. All aircraft data are in the form of fixes consisting of departure and arrival fixes 
and intermediate fixes if they are present, and presented in the popup in alphabetical order. 
To search through the database after a particular aircraft, use the scroll bar on the right of the 
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popup window. Select the flight plan of interest and then XPVD will graphically display its 
flight plan.  When finished use the ‘Dismiss’ button.  
 
An example of the Flight Plan popup menu is shown below. 
 
 

Figure 3.3-16 Flight Plan Submenu of Display Main menu – Flight VFR51 is displayed. 
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3.3.3.5 Lat/Lon Fix 
 
 The submenu Lat_Lon_Fix_popup of the Display menu gives one the possibility to enter a 
new fix into the simulation with the knowledge of the latitude and longitude. These values 
must be given in the format shown accompanied by a name of that particular fix. . In the 
example the fix name is XPVD_TEST and at the bottom of the screen are the latitudes and 
longitudes written out. 
 

Figure 3.3-17 Lat/Lon Fix shown 
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3.3.3.6 Radars 
 
The RADAR submenu of the Display menu consists of two columns. The first column 
consists of all the names of the radar sites participating in the scenario. The second column 
consists of the corresponding rings of each radar site.  
 

Figure 3.3-18 Radar pop-up menu from Display sub-menu 
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The diagram below displays 8 selected radar sites. 
 
 
 

Figure 3.3-19 Radar sites displayed. 
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This diagram displays the ring around chosen radar sites.  This ring or halo defines the radar 
reach for each defined radar site. 
 
 
 

Figure 3.3-20 Radar rings are displayed 
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3.3.3.7 Routes 
 
The next submenu in the Display menu section is the Routes menu. All routes that are in the 
database and associated with an aircraft will be found and displayed when called upon. Click 
on the name of the aircraft as shown below. The name will appear in the ‘Selection’ portion 
of the dialog box. Click ‘OK’ and that route will appear on the XPVD screen as shown in the 
same figure. Below is the route for QXE322. It will fly airway V120 starting at fix EAT and 
ends at fix GEG. 
 

Figure 3.3-21 Route for aircraft QXE322 is displayed  
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3.3.3.8 Sectors 
 
The last submenu of the Display menu is the Sector menu. Below is the Highlight Sectors 
menu which enables certain sectors to be more highlighted than others depending upon the 
selection. 
 
 

Figure 3.3-22 Sectors Submenu of Display menu  
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Figure 3.3-23 Selected Sectors are highlighted 
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Figure 3.3-24 Highlight has been turned off 
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3.3.4 TGF Menu 
 

3.3.4.1 Connect 
 
Connect will enable the XPVD application to connect to the specific tgf chassis chosen in the 
“Specify” submenu.  See Specify below. 
 

3.3.4.2 Disconnect 
 
Disconnect will disable the connection between the tgf chassis and the XPVD application. 
 

3.3.4.3 Specify 
 

3.3.4.3.1 Normal XPVD Runs 
 
The first job of the XPVD operator is to Specify and Select the tgf chassis with which the 
simulation is taking place on. First, click the specify selection. The select pop-up sub-menu 
will appear.  Then click on the chassis that the simulation is running on. Click “OK”.  See the 
diagram below. 
 

Figure 3.3-25 Choose a chassis at start-up 
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3.3.4.3.2 Advanced Programming XPVD Runs 
 
The Expert brings up a dialog box so that the user can enter the appropriate SDS server 
machine name and its port number. In the figure below, the SDS server name is d2 and port 
number 7011 is used for communication. 
 
 

Figure 3.3-26 Expert Specifying 
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3.3.5 Customize Menu 
 
The Customize menu from the main menu is displayed below. 
 
 

Figure 3.3-27 The Customize Menu 

 
 

3.3.5.1 White Background 
 
The White background switches the normal background of black to white. 
 

3.3.5.2 Black & White 
 
Converts the normal “color” representation to black and white. 
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3.3.5.3 Lat/Lon Grid 
 
The Lat/Lon Grid is depicted in the figure below.  It places a rectangular grid over the entire 
XPVD display showing the latitudes and longitudes at each intersection displayed. 
 
 

Figure 3.3-28 Latitude/Longitude Grid is displayed 
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3.3.5.4 X Y Grid 
  
The X Y Grid is XPVD screen is displayed below.  The display between the lat/lon and XY 
grids are similar, however, the lat/lon tends to have a curved outlook as it attempts to follow 
the earth’s lines, while the XY-coordinates are represented on a plane two dimensional area. 
This gives it its flat rectangle look. 
 

Figure 3.3-29 X, Y Grid is displayed 
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3.3.5.5 Preferences 
 
The Preferences submenu of the Customize menu contains numerous controls to enable the 
user to abstract specific data pertinent to the project at hand.  See the Preferences Menu on 
the next page. 

3.3.5.5.1 Mouse Preferences 
 
The Mouse button when clicked enables the standard mouse resident within the system or it 
enables the simulation operators’ mouse. 
 
 

3.3.5.5.2 FONT Preferences 
 
The Font menu enables/disables the following fonts: 
• 5 X 7 
• 6 X 10 
• 7 X 13 
• 8 X 13 bold 
• 9 X 15 bold 
• 10 X 20 
• 12 X 24 
 
 

3.3.5.5.3 Clock Rate Preferences  
 
The Clock Rate (in seconds) menu gives the time if other than one second that the clock is 
incremented.  An example of a 6 seconds rate is that every 6 seconds the clock is updated. 
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Figure 3.3-30 Preferences Submenu of Customize Menu  
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3.3.5.5.4 History Preferences 
 
History (scans) menu places a “tail” at the end of the target. The length or “time” is the 
number of scans indicated on the sliding bar when moved with the mouse. See the diagram 
below for further explanation 
 
 
 

Figure 3.3-31 History “tails” set at 50 
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3.3.5.5.5 Radar Scan Rate (Seconds) Preferences 
 
Radar Scan Rate (seconds) indicates how many radar sweeps per second is represented on the 
XPVD screen. See the figure below.  Notice how blurry the image appears with a Radar Scan 
Rate of 10.  This rate of 10 should be used with pre-recorded data. 
 

Figure 3.3-32 Radar Scan Rate Preferences displayed 
 

 

3.3.5.5.6 Screen Update Rate Preferences 
 
Screen Update Rate (seconds) indicates how many seconds before the XPVD screen is 
updated. A 5 seconds update means that after 5 seconds all positions will remain still until 
the fifth second.  At the fifth second the aircraft positions are updated on the XPVD screen.  
 
 

3.3.5.5.7 Map Altitude Preferences 
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Map Altitude shows the physical view of the sectors’ altitude. Compare the history tail figure  
and the Map altitude figure below.  Notice the lack of lines and detail between the two 
diagrams. 
The map altitude in the figure below is set to 400.  In reality, this number is 400 times 100 
feet or 40,000 feet.  Therefore the diagram below is looking at the same area 40,000 feet 
above the ground.  At this distance notice how sectors are eliminated from the view.  
Note that a setting of “-1” indicates that all sectors are shown. 
 

Figure 3.3-33 Map Altitude is set to 400 
 

. 
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3.3.5.5.8 Predictor Preferences 
 
The Predictor (seconds) sets a “stinger” before the target to indicate how many scans before 
the target reaches a specific area. The stinger in the diagram below is set to 25 and therefore, 
the stinger shows where the aircraft will be in 25 seconds from now. 
 
 

Figure 3.3-34 Predictor “stinger” preference is set to 25 
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3.3.5.5.9 Halo Preferences 
 
The Halo is at setting 5.0.  This means that the ring around an aircraft is set at 5 miles. See 
the halo associated with aircraft N618 in the diagram below.  
 

Figure 3.3-35 Halo Preference displayed 
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3.3.5.5.10  Comm Freq Preferences 
 
The Comm Freq, (Communication Frequency), if entered will enable the controller to filter 
out all traffic not on that particular frequency. Traffic of other frequency will appear as small 
targets without data blocks. If zeros are entered then all traffic is shown. As an example 
below, a frequency of 135.525 was entered.  Only the aircraft with that frequency appears 
with its full data block. All other aircraft appear as targets. See the figure below. 
 

Figure 3.3-36 Communication Frequency Preferences displayed 
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3.3.5.5.11 Airway/Route Fix Display Preferences 
 
In order to display airway routes and fixes, click the on button. 
To suppress viewing airway routes and fixes, click the off button. 
 
 

3.3.5.5.12  Dismiss 
 
Clicking on “dismiss”, removes the Preferences submenu of the Customize menu. 
 

3.3.5.6 Current Aircraft 
 
The Current Aircraft submenu of the Customize menu is shown below.  The Current Aircraft 
submenu monitors the particular aircraft that the controller specifies. Shown below in 
Current Aircraft is specify and when this “SPECIFY” is clicked the sub submenu CURRENT 
ACID_popup appears. 
 

Figure 3.3-37 Customize Current Aircraft is displayed  
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The diagram below depicts a Specified aircraft, N618, with Track North, Track Heading, and 
Halo all active.  TCAS filter is not active. 
 

Figure 3.3-38 Customize Current Aircraft N618 – TCAS off 
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The diagram below depicts a Specified aircraft, N618, with Track North, Track Heading, and 
Halo all active.  The Terminal Collision Avoidance System (TCAS) filter is active.  The 
TCAS filter is the figure eight looking boundary around aircraft N618.  Notice aircraft 
PRIME at a safe higher altitude. 
 
 

Figure 3.3-39 Current Aircraft customized with TCAS Filter “ON”. 
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3.3.6 Transform Menu  

3.3.6.1 Rotate and Scale 
 
The Transform menu gives the controller the option to rotate and to scale the map 
accordingly. When you rotate the map counter clockwise use the ‘minus’ or ‘hyphen’ sign. 
 

Figure 3.3-40 Transform’s - Rotate and Scale submenus 



 48

 
 
 
The figure below shows the XPVD screen with a rotation of 30 degrees and a scale of 10 
nautical miles. Compare this to the figure on the following page with its scale of 101 nautical 
miles and zero degrees rotation. Notice the scale “legend”. 
 
 

Figure 3.3-41 Rotated 30 degrees and 10 Nautical Miles displayed 
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Figure 3.3-42 Rotated 0 degrees and Scaled at 101 Nautical miles 
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3.3.7 Help Menu 
 
The last menu is the Help Menu. It gives the key combinations in order to manipulate the 
map when zooming in and out, centering, calculating distances, drawing lines, and turning 
the menus off and on to name a few of the multifaceted functions the XPVD tool can 
accomplish.  
 
 

Figure 3.3-43 Help Menu 
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4 XPVD SDSERVER Programming Interface 

4.1 Communication Protocol 
 
The SDSERVER receives flight information from TGF via directed UDP protocol. 
In turn, the SDSERVER will save pre-flight information in an internal table.  When a XPVD 
is initially connected to sdserver this flight information is transferred to XPVD via either 
UDP or TCP connections.  The following sections depict the different communication 
protocols.  

4.1.1 UDP INTERFACE 
 
The XPVD that runs on the SPW’s communicate via UDP with the SDSERVER. 
Figure 4.1-1 illustrates the UDP protocol. 
 

4.1.2 TCP INTERFACE 
All other XPVD workstations communicate with the SDSERVER via TCP. 
Figure 4.1-2 illustrates the TCP communication protocol. 
 
 

4.1.3 XPVD TO XPVD INTERFACE 
 
XPVD clients may on occasion need to speak to all other SPW XPVD clients.  This is 
accomplished with the INTERCLIENT message.  Figure 4.1-3 illustrates the INTERCLIENT 
data flow. 
 



 52

 

Figure 4.1-1 XPVD – SDSERVER UDP PROTOCOL 

 
 

SDSERVER XPVD TIME 

Set up udp broadcast socket 

Send flight data

Connect sent 

Send Preflight data 

Send flight data 

End of Epoch 

Disconnect Sent 

No reply 
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Figure 4.1-2 XPVD – SDSERVER TCP PROTOCOL 
 

SDSERVER XPVD TIME 

Set up listening tcp socket 

A connect to receive pre-flight data is sent

Send Pre-flight data 

Send flight data 

End of Epoch 

Disconnect Sent 

Sever TCP connection 

Connection requested 

Send acknowledgement of connection 
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Figure 4.1-3 XPVD – XPVD CLIENT INTERFACE 

SDSERVER XPD TIME 

Transmit message to all other PVDs’ 

Interclient data request sent 

Reserve source address
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4.2 Data  
 
The following section describes the messages sent from SDSERVER to XPVD. 
 

4.2.1 GENERAL INFORMATION 
 
The following is a list of the messages that are sent from the SDSERVER to XPVD.  Each 
one shall be discussed in this chapter. 
 

Table 4.2.1-1 List of Message Identifiers  

  Message 
Identifier 

Value Description 

SIM_INIT 302 TGF sends SDS at start of new 
sim 

ACK   302   acknowledgement message  
CONNECT   303 connection accepted ∗ 
END_DATA   306 end of flight data  
SDS_HANGUP   308 SDS has disconnected or 

XPVD has disconnected  
PREFLIGHT   310 pre-flight data  
FLIGHT   311 flight data  
TERM_FLIGHT   312 terminate flight 
INTERCLIENT   313 interclient data  
WXLO   314 weather low messages  
WXHI 315 High intensity weather 

messages 
WXMD 316 Medium intensity weather 

messages 
REQ_FPLAN 317 Request pre-flight messages 
 
∗ The CONNECT is an exception in the list.  This message is from XPVD to SDSERVER.  It 
is sent on an initial connection to the SDSERVER.  This CONNECT informs the 
SDSERVER to download the pre-fight message database to XPVD.  This assures that all 
active target information is visible on the XPVD screen.  
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The general format of the messages from SDSERVER to XPVD starts with one of the 
message identifiers as described above followed by the data for that message.  
 

Table 4.2.1-2 General Format of the data sent from SDSERVER to XPVD 

FIELD LENGTH  IN BYTES FORMAT 

Message Identifier 4 Enumeration 

Data Variable Variable 

  
 
 

4.2.2 Request for Pre-Flight Messages 
 
Whenever a new XPVD application starts, XPVD requests the pre-fight data from 
SDSERVER.  The layout for the request for pre-flight messages is below. 
 

Table 4.2.2-1 Format for Request for Pre-flight Messages 

FIELD 
DESCRIPTION 

INTERNAL 
DATA NAME1 

LENGTH 
IN BYTES 

FORMAT VALUE 

Message Identifier Msgn 4 Enumeration 317 

Flight Identifier Flight_id 8 ASCII  
Spare Spare 4 character  
 
 

4.2.2.1 Message Identifier 
 
The message identifier for a request for preflight message is the value “REQ_FPLAN”. 
The numeric value for this is “317”.  One of these messages exist per starting XPVD. 
 
 

4.2.2.2 Flight Identifier  

                                                 
1 The actual data names found in the source code for CTG, TG, SDSERVER, and XPVD are all in lower case. 



 57

 

4.2.3 TGF PRE-FLIGHT MESSAGES 
 
A short synopsis from the “TGF Universal Flight Plan ICD” was used for the field 
definitions found in this ICD. For a more thorough discussion or understanding of the fields 
mentioned here, one should click this “TGF Universal Flight Plan ICD”.   

Table 4.2.3-1 Format of Pre-flight Message 

FIELD 
DESCRIPTION 

INTERNAL 
DATA NAME2 

LENGTH 
IN BYTES 

FORMAT VALUE 

Message Identifier Msgn 4 Enumeration 310 

Departure Time Departure_time 4 Integer  
Aircraft Identifier Flight_id 8 ASCII String Alphanumeric 
Aircraft Type Ac_type 12 ASCII String  
Destination Fix Dest_fix 28 ASCII String  
Route Route 128 ASCII String  
Assigned Altitude Assigned_altitude 4 Floating point  
Filed speed  Filed_speed 4 Floating point  
Frequency Freq 4 Binary  
Beacon code Beacon 2 Binary  
Spare Spare 2 ASCII String  
Runway Name Runway 8 ASCII String  

4.2.3.1 Message Identifier 
  
The message identifier for a preflight message is the value “PREFLIGHT”. 
The numeric value for this is “310”.  One of these messages exist per starting aircraft in a 
simulation 
 

4.2.3.2 Departure Time 
 
This is the departure time that is relative to the commencement of the simulation.  
If the user enters a start time of 0 this flight will await a manual start. 
 

4.2.3.3 Aircraft Identifier 
 

This field contains the aircraft identification (ID).  This ID is used as the name of the flight 
both in discussion and in data reduction and analysis. 
 
The ID starts with a letter and is followed by one to six alpha-numerics. 
                                                 
2 The actual data names found in the source code for CTG, TG, SDSERVER, and XPVD are all in lower case. 
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4.2.3.4 Aircraft Type 
 
This field is up to 12 bytes long and represents the type of aircraft and the airborne 
equipment qualifier.  It may also include a number of flights indicating that more than one 
aircraft will be sharing this flight plan.  This field also includes a weight class indicator. 
 
This field is used to determine aircraft performance and navigational characteristics. 
 
 

4.2.3.5 Destination Fix 
 
This field contains the destination fix which could be either a point where the aircraft is 
handed off to another sector, or control is transferred, or represents the destination airport fix.  
 

4.2.3.6 Route 
 
This field contains the TGF route of flight. This is a list of navigational fixes and airways that 
make up the route the aircraft will travel.  The aircraft will start at the initial fix and continue 
following each step of the flight plan until it terminates or lands at the final fix. 
 
The route may contain reference to a published route as one that is found in a FAA document 
or a simulation route as derived for this simulation by the customer and TGF staff. 
 

4.2.3.7 Assigned Altitude 
 
This field represents the altitude to which the aircraft will climb or descend, if it is different 
from the TGF starting altitude. 
 

4.2.3.8 Filed Speed 
 
This field is the highest speed TGF will fly the aircraft.  This is the cruising speed of a filed 
flight plan.  In addition, this is the airspeed that is normally filed in a NAS flight plan. 
 
 

4.2.3.9 Frequency 
 
This field contains the air-to-ground VHF frequency for the initial (controlling) sector. 
 
The flight will begin the simulation in the sector controlled by this frequency.  This 
frequency is also used to assign the flight to a simulation pilot. 
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4.2.3.10 Beacon Code 
 
This field contains the beacon code assigned to the aircraft.   
 

4.2.3.11 Spare 
 
This field is used for padding.  It is 2 bytes in length and is required for alignment. 
 

4.2.3.12 Runway Name 
 
This field contains the aircraft's departure runway.  This field may also contain a heading       
to be flown from the runway.  A departure runway is required for Standard Instrument 
Departures (SIDS).  If a departure runway is not specified, the aircraft will fly from the 
airport directly to the first fix on its route.   This heading field can hold a heading to be flown 
from the starting point in an ARTS simulation. 
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4.2.4 FLIGHT MESSAGES 
 

Table 4.2.4-1 Format of Flight Message 

FIELD 
DESCRIPTION 

INTERNAL 
DATA NAME 

LENGTH IN 
BYTES 

FORMAT VALUE 

Message Identifier Msgn 4 Enumeration 311 
Time Time 4 Integer  
Aircraft Identifier Flight_id 8 ASCII String  
Longitude Lon_degs 4 Floating point  
Latitude Lat_degs 4 Floating point  
Ground Speed Ground_spd_mph 4 Floating point  
Heading Hdg_degs 4 Floating point  
Altitude Alt 4 Floating point  
Climb Rate Climb_rate_ftsec 4 Floating point  
Frequency Freq 4 Binary  
Beacon Code Beacon 2 Binary  
Ident Control Ident 1 Flag  
Highlight a/c Highlight 1 Flag  
 

4.2.4.1 Message Identifier 
.  
The message identifier for a flight message is the value “FLIGHT”.  The numeric value for 
this is “311”.   
 

4.2.4.2 Time 
  
This field represents the simulation time in seconds.  It is not the time relative to the 
beginning of the sim nor does it represent the real world time.   

4.2.4.3 Aircraft Identification 
  
This field contains the aircraft ID.  This ID is used as the name of the flight both in 
discussion and in data reduction and analysis. 
 
The ID starts with a letter and is followed by one to six alpha-numeric characters. 
 

4.2.4.4 Longitude 
 

This is the current longitude that the aircraft is flying. 



 61

 

4.2.4.5 Latitude 
 

This is the current latitude that the aircraft is flying. 
 

4.2.4.6 Ground Speed 
 
This is the airspeed in terms of the ground as a reference point. 
  

4.2.4.7 Heading 
 
This is the current direction the aircraft is flying. 
  

4.2.4.8 Altitude 
 
This is the current altitude of the aircraft. 
  

4.2.4.9 Climb Rate 
 
This field describes how fast an aircraft is climbing/descending in feet. 

 

4.2.4.10 Frequency 
  
This field contains the air-to-ground VHF frequency for the initial (controlling) sector. 
 
The flight will begin the simulation in the sector controlled by this frequency.  This 
frequency is also used to assign the flight to a simulation pilot. 
 
 

4.2.4.11 Beacon Code 
 
This field contains the beacon code assigned to the aircraft.   
 

4.2.4.12 Ident 
 
Some transponders are equipped with an Ident button.  During a Simulation the controller 
may request a pilot to hit the ident, as a result a special symbol shall appear at the controller’s 
workstation. 
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4.2.4.13 Highlight 
  
This is a byte flag field.  This field is used to indicate which aircraft is from the cockpit 
simulator workroom. 
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4.2.5 TERMINATE FLIGHT MESSAGE  
 
This message is issued when an aircraft is to end its simulation flight.  As a result of this 
command, the aircraft will disappear from the XPVD screen. 
 

Table 4.2.5-1 Format of Terminate Flight Message 

FIELD 
DESCRIPTION 

INTERNAL 
DATA NAME 

LENGTH IN 
BYTES 

FORMAT VALUE 

Message 
Identifier 

Msgn 4 Enumeration 300-316 

Aircraft 
Identification 

Flight_id 8 ASCII String  

Spare Spare 4 N/A  
 

4.2.5.1 Message Identifier 
 
The message identifier for a terminate flight message is the value “TERM_FLIGHT”. 
The numeric value for this is “312”.   
 

4.2.5.2 Aircraft Identification 
 
This field contains the aircraft ID.  This ID is used as the name of the flight both in 
discussion and in data reduction and analysis. 
 

4.2.5.3 Spare 
 
This field is used for padding.  It is 4 bytes in length and is required for alignment. 
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4.2.6 WEATHER LOW INTENSITY MESSAGES 
 
Weather data comes off the radar sites in rho theta format.  It is received off the BYTEX in 
digitized format.  Low intensity weather is used in detecting the start of precipitation. 
 

Table 4.2.6-1 Format of the data for Weather Low Intensity 

FIELD 
DESCRIPTION 

INERNAL 
DATA NAME 

LENGTH IN 
BYTES 

FORMAT VALUE 

Message 
Identifier 

Msgn 4 Enumeration 300-316 

Time  Time 4 Binary  
Site Identifier Site_id 12 ASCII String  
Azimuth Azimuth 4 Binary  
Start of Range Range_start 4 Floating point  
Range Stop Range_stop 4 Floating point  
 

4.2.6.1 Message Identifier 
 
The message identifier for a weather low intensity message is the value “WXLO”. 
The numeric value for this is “314”.   
 

4.2.6.2 Time 
  
This field represents the simulation time in seconds.  It is not the time relative to the 
beginning of the sim nor does it represent the real world time. It is the sim time that the 
weather message is received. 
 

4.2.6.3 Site Identifier 
  
This field identifies the radar sites receiving radar data for the simulation.  Each radar site has 
up to 3 characters.  An instance of weather may therefore be received by up to 4 radar sites.  
The radar site is the reference point for the azimuth and range data. 

4.2.6.4 Azimuth 
 

This field represents the theta or angle from the radar site to the piece of weather data. 
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4.2.6.5 Start of Range 
  
This field is derived from the rho of the rho theta weather format received off the BYTEX.  
In particular, the start of range refers to the defined distance from the named radar sites to the 
particular weather phenomena, namely the beginning of the precipitation. 
 

4.2.6.6 Range Stop 
  
This field is derived from the rho of the rho theta weather format received off the BYTEX.  
In particular, the end of range refers to the defined distance from the named radar sites to the 
end of a particular weather phenomena, namely the end of the precipitation. 
 
 

4.2.7 WEATHER HIGH INTENSITY MESSAGES 
 
High intensity weather refers to rain and heavier rain. 
 

Table 4.2.7-1 Format of the Weather High Data Packet 

FIELD 
DESCRIPTION 

INERNAL 
DATA NAME 

LENGTH IN 
BYTES 

FORMAT VALUE 

Message 
Identifier 

Msgn 4 Enumeration 300-316 

Time  Time 4 Binary  
Site Identifier Site_id 12 ASCII String  
Azimuth Azimuth 4 Binary  
Range Range 4 Floating point  
 

4.2.7.1 Message Identifier 
long msgn 
 
The message identifier for a high intensity weather message is the value “WXHI”. 
The numeric value for this is “315”.   
 

4.2.7.2 Time 
   
This field represents the simulation time in seconds.  It is not the time relative to the 
beginning of the sim nor does it represent the real world time. It is the sim time that the 
weather message is received. 
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4.2.7.3 Site Identifier 
  
This field identifies the radar sites receiving radar data for the simulation.  Each radar site has 
up to 3 characters.  An instance of weather may therefore be received by up to 4 radar sites.  
The location of the radar site is the reference point for the azimuth and range data. 
 

4.2.7.4 Azimuth 
 

This field represents the theta or angle from the radar site to the piece of weather data. 
 

4.2.7.5 Range 
   
This field is derived from the rho of the rho theta weather format received off the BYTEX.  
The high intensity weather is worse than low intensity weather, it implies precipitation is 
present.  For this reason, there is no range start and no range stop for high intensity weather.  
The radar can’t detect the start or stop of this particular weather.  So the range for high 
intensity weather refers to the defined distance from the named radar site to the particular 
weather storm. 
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4.2.8 WEATHER MEDIUM INTENSITY MESSAGES 
 
Medium intensity weather refers to rain and heavier rain. 
 

Table 4.2.8-1 Format of the Weather High Data Packet 

FIELD 
DESCRIPTION 

INERNAL 
DATA NAME 

LENGTH IN 
BYTES 

FORMAT VALUE 

Message 
Identifier 

Msgn 4 Enumeration 316 

Time  Time 4 Binary  
Site Identifier Site_id 12 ASCII String  
Azimuth Azimuth 4 Binary  
Range Range 4 Floating point  
 

4.2.8.1 Message Identifier 
 
The message identifier for a medium intensity weather message is the value “WXMD”. 
The numeric value for this is “316”.   
 

4.2.8.2 Time 
   
This field represents the simulation time in seconds.  It is not the time relative to the 
beginning of the sim nor does it represent the real world time.   
 

4.2.8.3 Site Identifier 
  
This field identifies the radar sites receiving radar data for the simulation.  Each radar site has 
up to 3 characters.  An instance of weather may therefore be received by up to 4 radar sites.  
The radar site is the reference point for the azimuth and range data. 
 

4.2.8.4 Azimuth 
 

This field represents the theta or angle from the radar site to the piece of weather data. 
 



 68

4.2.8.5 Range 
   
This field is derived from the roe of the roe theta weather format received off the BYTEX.  
The medium intensity weather is worse than low intensity weather, it implies precipitation is 
present.  For this reason, there is no range start and no range stop for medium intensity 
weather.  The radar can’t detect the start or stop of this particular weather.  So the range for 
medium intensity weather refers to the defined distance from the named radar site to the 
particular weather storm. 
 
 
 

4.2.9 INTERCLIENT MESSAGES 
 
This message is sent from XPVD to the SDSERVER. In turn SDSERVER will take this 
message and broadcast the message to all XPVD clients.  The table below outlines the 
contents of an interclient message. 
 

Table 4.2.9-1 Format of Interclient Message 

FIELD 
DESCRIPTION 

INTERNAL 
DATA NAME 

LENGTH IN 
BYTES 

FORMAT VALUE 

Message 
Identifier 

Msgn 4 Enumeration 300-316 

Aircraft 
Identification 

Flight_id 8 ASCII String  

Source Address Src_addr 4  I/P address  
Spare Spare 16 N/A  
 

4.2.9.1 Message Identifier 
 
The message identifier for an interclient message is the value “INTERCLIENT”. 
The numeric value for this is “313”.   
 

4.2.9.2 Aircraft Identification 
This field contains the aircraft ID.  This ID is used as the name of the flight both in 
discussion and in data reduction and analysis. 
 
The aircraft ID is 7 alphanumeric bytes long, with the first character an alphabetic. 
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4.2.9.3 Source Address 
       
This field identifies the XPVD workstation that has a message to convey to all other XPVD 
clients. 
 

4.2.9.4 Spare 
 
This field is used for padding.  It is 16 bytes in length and is reserved for future use. 
 
 

4.2.10 Communication Status data packets 
 
The following messages just consist of the message identifier only: 
 
• SIM_INIT – TGF sends SDSERVER at the start of a new sim 
• ACK – acknowledgement of connection  
• CONNECT – data connection and data wanted 
• END_DATA – end of flight data epoch has been reached 
• SDS_HANGUP – SDS has terminated 
• TGF_HANGUP – TGF has terminated 
 
There is no data for these messages.   
The format for these messages is shown in below. 
 

Table 4.2.10-1  Format of SDS_INIT, ACK, CONNECT, END_DATA, HANGUPS 

FIELD LENGTH  IN BYTES FORMAT 

Message Identifier 4 Enumeration 
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5 XPVD Exercise Control Workstation Interface 
 
 
Initial booting of the Simulation Pilot (SimPilot) Workstations (SPW) takes place at the 
beginning of a simulation (sim).  The simulation lead clicks on the wanted SimPilot 
workstation ICONS via a GUI Interface at the ECW (Exercise Control Workstation).  The 
ECW is also referred to as the ECO. The ECO software is responsible for configuring the 
requested SPWs at this time.  The GUI interface is depicted in the figure below. 
 
During this boot the XPVD software is started at these SPWs.  The target data generated at 
these XPVDs at the SPW is via a UDP broadcast from the SDSERVER.  
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Appendix A: Commands 
 

1.1 AIRWAY Command 
The AIRWAY command is used to define the airways composed of the 

fixes in the database. These airways are published and are taken from the 

ACES data. 

1.1.1 AIRWAY Command Syntax: 
AIRWAY name  fix1  fix2  … fixn name

 fix1 fix2 

1.1.2 Examples: 
AIRWAY  V112 HQM ILWAC … YXC188037 YXC 

AIRWAY J14 GSO 99514 … COLIN PXT 

1.1.3  ARGUMENTS: 

 AIRWAY: String denoting the name of airway. 

 fix1,  fix2, …fixn: The name of the fixes and FRD's that make up the 

airway.  

1.1.4 ARGUMENT Format: 

name: a string of non-blank characters denoting the name of the 

airway. 

 fixn:  a string of non-blank characters denoting the name of the: 
fix. 

   keyword: fixn… 
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1.2 CENTER Command 
 

The CENTER command defines the center of the viewed area. 

1.2.1 CENTER Command Syntax: 

CENTER  LL Latitude Longitude 

CENTER XY x  y  

1.2.2 Example: 
CENTER  LL 391024 764018 

CENTER XY -0.241 -0.583 

1.2.3 Arguments: 

Latitude: Defines the latitude to be positioned at the center of the viewed 

area. 

Longitude: Defines the longitude to be positioned at the center of the 

viewed area. 

x-coordinate: x - coordinate to be positioned at the center of the 

viewed area. 

y-coordinate: y - coordinate to be positioned at the center of the 

viewed area. 

1.2.4 Argument Format: 

Latitude: [h]hhmmss[.xxx] 

Longitude: [h]hhmmss[.xxx] 

x:  n[.n] 

y:  n[.n] 
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1.3 DISPLAY Command 
The DISPLAY command renders the location of the object on the screen. 

 

1.3.1  DISPLAY Command Syntax 

 DISPLAY object  name 

1.3.2  Example 
DISPLAY FIX Belay 

DISPLAY AIRWAY J123 

1.3.3  Arguments: 
 
object: a string of characters denoting the type of object. 

name:  a string of characters denoting the name of the object. 

1.3.4  Argument Format: 

object:  string 

name:  keywords: FIX, AIRWAY, ROUTE 
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1.4 FIX Command 
 

The FIX command defines the fix's coordinates in the XPVD database in 

either latitude/longitude or xy-coordinates. 

1.4.1  FIX Command Syntax: 

FIX name LL Latitude Longitude magnetic_declination 

FIX name XY x-coord y-coord magnetic_declination 

 

1.4.2  Example: 
FIX Belay LL 393515 761801  12 

FIX Belay XY 16.987 24.276  15 

1.4.3  Arguments: 

Name: a string of non-blank characters denoting the name of the 

fix. 

Latitude:  Defines the latitude of the fix's location. 

Longitude:  Defines the longitude of the fix's location. 

x-coord: x - coordinate of the fix's location. 

y-coord: y - coordinate of the fix's location. 

1.4.4  Argument Format 

Name: String 

Latitude: [h]hhmmss[.xxx] 

 Longitude: [h]hhmmss[.xxx] 

x-coord: n[.nn] 

 x-coord: n[.nn] 
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1.5 NODE Command 
The NODE command enables the placement of points of intersections of 

sector boundaries. 

1.5.1 NODE Command Syntax 

NODE name  LL latitude longitude 

1.5.2 Example: 

NODE  X222  LL  462030  1255750 

NODE  X223  LL  454856  1265200 

1.5.3 Arguments: 

name:  A string of non-blank characters denoting the name of 

the Node. 

latitude: Defines the latitude of the Node's location. 

longitude: Defines the longitude of the Node's location. 

1.5.4 Argument Format: 

name:  A string of non-blank characters denoting the name of 

the Node. 

latitude: [h]hhmmss[.xxx] 

longitude: [h]hhmmss[.xxx] 
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1.6 ROUTE Command 
The ROUTE command defines the actual route the aircraft will take. It 
consists of fixes that have been defined in the database or given through 
the pop-up command interface. 
 

1.6.1 ROUTE Command Syntax 
 ROUTE   name  fix1  fix2…  
1.6.2 Example: 

ROUTE  BOE620 MWH  GEG  MWH 
 

1.6.3 Arguments: 
name:  String denoting the name of route. 
fix1…:  The name of the fixes and FRD's that make up the route. 
 

1.6.4 Argument Format: 
 name:  a string of non-blank characters denoting the name of the 

route. 

 fix1…: keyword: fix1… 
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1.7 RSITE Command 
The RSITE command is for radar site placement consisting of their XY 

coordinates. 

1.7.1 RSITE Command Syntax 

RSITE name  XY x-coord y-coord  range 

(nm) 

1.7.2 Example: 
RSITE  QMO   XY  282.1250 326.6250  200.0 

RSITE  QMI   XY  544.2500 522.5000  200.0 

 

1.7.3 Arguments: 

name:  A string of non-blank characters denoting the name of the 

radar site. 

x-coord: x-coordinate of the radar site's location. 

y-coord: y- coordinate of the radar site's location. 

range: The range of the radar site in nautical miles. 

1.7.4 Argument Format: 

name:  A string of non-blank characters denoting the name of the 

radar site. 

x-coord: n[.nnn] 

y-coord: n[.nnn] 

range:  n[.nnn] 
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1.8 RUNWAY Command 
 

The RUNWAY command is used to define values for airport runways and 

related characteristics. The command consists of four different formats, each 

defining separate aspects of the named runway. The particular format to be used 

is based on the third word in the command line, which can be: RUNWAY, 

LOCAL, SLOPE, or ZONE. Each one of these commands are required, they 

must be entered in the specified order. The RUNWAY/RUNWAY command 

defines the runway end points and its width. The RUNWAY/LOCAL command 

describes the runway centerline extension. The RUNWAY/SLOPE command 

describes the glideslope features such as outer marker and intercept fix. The 

RUNWAY/ZONE command defines the boundaries of the NTZ (no 

transgression zone) which appears between runways.  

 

1.8.1 RUNWAY Command Syntax: 

RUNWAY name RUNWAY  lat1   lon1  lat2  

 lon2   width 

RUNWAY name LOCAL  angle   longend  direct  mapt 

RUNWAY name SLOPE  gs  om  fix 

RUNWAY name ZONE   tag   inner_end  divider_end  
 outer_end 
 
 

1.8.2 Examples:  
RUNWAY 18R RUNWAY   37373048.953 881524.921 372910.604 

881524.912 150.0 
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 RUNWAY 10 ZONE    tag  0.500  12.000  

 12.500 

RUNWAY 18R LOCAL   0.000   25.0   1.0  

 0.612368 

 RUNWAY 18R SLOPE    3.0  4.983737  

 12.388686 

 RUNWAY 18R ZONE 18C 0.500 15.690 15.7  

1.8.3 Arguments: 

Name: Defines the name of the runway (eg, 18L) and is up to 5 

non-blank    characters. 

 RUNWAY: Keyword to be followed by the latitude and longitude of the 

runway.  

LOCAL: Defines localizer and extended centerline.  

name:  Defines the name of the runway (eg, 18L)  

Angle:  is degrees for centerline offset.  

Longend:  is nautical mile length of plotted extended centerline.  

Direct:  is -1, 0 or 1 to specify direction of reference lines of the  

NTZ:  +1=up or left, -1=down or right, 0=both.  

Mapt: is distance from threshold to MAP (missed approach point) 

in nautical miles and affects where the 'kink' occurs in an 

offset approach. 

SLOPE: gs degrees (glideslope). 

Fix: The distance in nautical miles from threshold to stepdown 

fix 

       (ie, glideslope intercept) 

outer_end: Number of nautical miles from the reciprocal end of the 

runway to the end of the NTZ. 
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inner_end:  Number of nautical miles from reciprocal end of the runway 

to the reciprocal end of the NTZ. 

 

divider_end:   Number of nautical miles from the reciprocal end of 

the NTZ to the    divider (red vs yellow). 

Latitude:  Defines the latitude at the point of tangency of the 

stereographic projection. 

Longitude:  Defines the longitude at the point of tangency of the 

stereographic projection. 

Width: The width of the runway in feet. 

Tag: The second runway in the NTZ pair previously defined by 

RUNWAY/RUNWAY commad. 
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Below are figures that simplify a few of the terms used above: 

 

5.1.1 Figure 1.6.1 Image depicting runway 18R and the no transgression zones. 
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5.1.2 Figure 1.6.2 Image showing dual runways with 'kink' in the offset localizer. 
 

5.1.3  Figure 1.6.3 NTZ's with 'ends' shown for the MPAP map. 
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1.8.4 Argument Format: 

Latitude: [h]hhmmss[.xxx] 

 Longitude: [h]hhmmss[.xxx] 

X-coord: n[nn…] 

 Y-coord: n[nn…] 

Width: n[nn…] 

Tag:  String 

Mapt:  nn[n.nn] 

divider_end:  nn[n.nn] 

inner_end:  nn[n.nn] 

Fix:  nn[n.nn] 

Om:   nn[n.nn] 

Runway: String 

Slope: n[.nn] 
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1.9    SCALE Command 
 

The SCALE command defines the conversion factor per units of nautical 

miles on the XPVD screen. 

1.9.1 SCALE Command Syntax: 

 SCALE  X  Y 

1.9.2 Example: 
SCALE 1.0 1.0 

1.9.3 Arguments: 

X: a number denoting the scale along the x-axis in nautical miles.  

Y: a number denoting the scale along the y-axis in nautical miles.  

1.9.4 Argument Format: 

X: n[.n] 

Y: n[.n] 
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1.10  STEREOG Command 
 

The STEREOG command defines the stereographic projection used by 

the XPVD to convert measurements in Latitudes and Longitudes to XY 

coordinates and vice versa. 

1.10.1  STEREOG Command Syntax 

 STEREOG  Latitude Longitude Radius x-coord y-coord 

1.10.2  Example: 
 STEREOG  391107 0764055 0  -0.721  0.123 

 STEREOG 390950 0763944 0   0.203 -1.152 

1.10.3  Arguments: 

Latitude: Defines the latitude at the point of tangency of the 

stereographic projection. 

Longitude: Defines the longitude at the point of tangency of the 

stereographic projection. 

Radius: Conformal earth radius at point of tangency. A zero in this 

position will have XPVD calculate the value automatically. 

x-coord: x - coordinate in nautical miles at point of tangency. 

y-coord: y - coordinate at nautical miles point of tangency. 

1.10.4  Argument Format: 

 Latitude: [h]hhmmss[.xxx] 

 Longitude: [h]hhmmss[.xxx] 

 Radius: n 

x-coord: n 
 y-coord: n 


